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1. Content of package 

• ADVAPIX / MINIPIX Timepix3 device 

• USB 3.0 cable - ADVAPIX TPX3 

• +5 V DC adapter - ADVAPIX TPX3 

• USB memory stick with control software PIXET Pro 
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2. Start guide 

1. Connect the device to the water cooling system. Thermal stabilization to 20-25°C is strongly recommended. 

2. Connect the device to the computer via USB 3.0 or USB 2.0 cable(s). 

3. Plug in the power adapter (if it is needed) 

4. Connect the attached USB memory stick to the computer. 

5. Install the device drivers: 

− Microsoft Windows: run drivers/setup.exe and follow the instructions. 

− macOS: run drivers/D2xxHelper_v2.0.0.pkg. 

− Linux: installation of any special drivers is not required. 

6. Install the PIXET Pro application: 

PIXET Pro for Windows is distributed as a single executable file for automatic installation. Run setup.exe and 

follow the instructions it the setup wizard. 

PIXET Pro for macOS system is distributed as a standard dmg file (disk image file). After mounting the 

pixet.dmg file a window with disk content will open. To install, move the PIXET Pro folder to the Application 

folder. 

PIXET Pro for Linux system is distributed as a single tar file. To install, untar the file at a required location. The 

application is launched by executing the pixet.sh script. 

 

7. Run PIXET Pro application. An icon with ID of your device must appear in the left panel. 

 

Default configuration of the connected device is loaded automatically. Configuration file contains default settings 

of the detector including calibration of energy thresholds to keV. Settings of thresholds in keV and bias voltage 

are shown in the Detector Settings panel when the configuration is properly loaded. The device is now ready for 

use. However, it is advisable not to start any measurements until the thermal equilibrium is established (~ 20 

minutes). 
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Last detector settings with all your modifications are stored locally on your computer when PIXET Pro is closed. 

The settings will be loaded again when starting PIXET Pro with the same device next time. The defaults can be 

restored at any time by loading the default configuration: Click File → Load Config in menu bar and choose the 

configuration file using system dialog window. It is located in the Pixet/configs folder and has .xml extension. 
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3. Timepix3 

 

3.1 Timepix and Timepix3 – What is the difference? 

• All previous chips of Medipix/Timepix family utilized the frame-based readout, i.e. the whole pixel matrix 

was read-out at once. The Timepix3 has an event-based read-out where values recorded by pixel are read-

out immediately after the hit. This way a full information about each event is recorded comprising 

coordinates, energy and detection time for each hit pixel. The chip therefore generates a continuous stream 

of data rather than a sequence of frames. Timepix3 is therefore much faster then Timepix. 

 

• Timepix based detectors allow the photon counting, spectroscopic “time-over-threshold” and Time of arrival 

measurements. Each of these measurement modes must be run separately. The Timepix3 chip operates in 

all of them simultaneously. 

 

• The Timepix3 time resolution of 1.56 ns is much higher compared with Timepix whose time resolution is 

25ns  

3.2 The main features of Timepix3 

Timepix3 readout chip and fast interfaces make possible individual processing of every detected particle. Such event-

by-event imaging principle (list-mode) allows for extracting of more information from measured data. Thanks to it 

the Timepix3 read-out chip allows for suppression of secondary radiation generated inside of high-Z sensors such as 

CdTe or GaAs via internal XRF or Compton effect. This principle together with reconstruction of charge sharing effect 

for each particle a significant improvement of spatial resolution down to 14 microns is achieved even for hard X or 

gamma rays.  

Timepix3-based detectors have single energy threshold. All energies below the set value are cut off. Devices are set 

to a minimal threshold above noise by default. This is typically 5 keV fo CdTe sensor and 3 keV for silicon sensor. The 

threshold can be adjusted by user in the Event Count & iToT mode. 
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3.3 Timepix3 operation modes 

The Timepix3-based detector offers several operation modes. These modes are summarized in the table below.  

 
 

ToT &ToA –Time-Over-Threshold (ToT) & Time-Of- Arrival (ToA) running in data-driven mode is the most complex 

measuring mode that can be used for fully spectral data acquisition. This mode exploits a 10 bit counter working like 

a timer that determines the number of events (clks). This number is proportional to deposited energy of particle 

captured in the sensor. Simultaneously uses the 14 Global Timer to determine the time of arrival. 

The time resolution of Timepix3 chip (1.56ns) is given by fast ToA that determines a time of arrival with higher 

accuracy.  

It is important to note that in Timepix3, ToA value is not based on the shutter (like in Timepix) and is taken from a 

free-running global Gray counter instead. However, ToA values of rising/falling edges of the shutter can be obtained 

via Global Timer. If acquisition time is shorter than 14b-range * clock period (409.6us @ 40MHz), it is guaranteed 

that no ambiguities in ToA values exist.  The information about the position of hit pixel is noted in the same time. 

This all makes it possible to get complex information about each particle detected in the sensitive area.  

 

Only ToT - This mode internally blocks local oscillators and allows faster measurement of ToT in data-driven mode. 

Event Count & Integral ToT  

Mode of operation Event Count & Integral ToT is one of reasonable and usable mode based on frame readout. It 

works as a counter of all detected particles and as a timer for energy-dependent measurement. The Event Count 

measures every detected particle hit in the sensor. The counter is increased if the detected pulse is above the energy 

level. Integral ToT measures the energy of the particle which is proportional to the length of the pulse. This mode 

works the same as for Timepix chip with the respect of a number of particles detected in one frame. 
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To measure energy must be selected the time as low as would be possible to distinguish the particles from each 

other. In the case the time would be selected inappropriately the particles will be overlapped and then it does not be 

possible to determine the real energy of the measured particle.  

Timepix3 also offers to switch between the additional modes of measurements which are allowed in the menu for 

modes of measurement. Then is the ability to measure even ToT and ToA or only ToA. The rule of correct acquisition 

time selection applies here also as well as for using iToT measuring mode. 

3.4 Timepix3 data formats 

Each pixel in Timepix3 data file is 64bit long. The frames of type u64 are used. Each pixel value in the file contains 

multiple information - ToT, Toa, iTot, etc. based on the Timepix3 detector measurement settings. The data can be 

saved and replayed using the following file formats: 

 

− Timepix3 Pixels ASCII File (*.t3pa) 

− Timepix3 Pixels Binary File (*.t3r) 

− Timepix3 Raw Data File (*.t3p) 

The list of the commonly used formats is described in the following section. 

ASCII File (*.t3pa) 

This file is specific for Timepix3 detector. It contains a stream of pixels received from the detector. It is a ASCII file. 

The file starts with a header line: 

 

Each following line contains a single pixel. Where the values are: 

− Index - index of the pixel in the file. Starting from 0 

− Matrix Index - position (index) of the pixel in pixel matrix - for single detector 0 - 65535, where 0 – 255 are 

pixels in first row, 256 - 511 second row, ... 

− ToA - ToA value of the pixel (raw detector value) 

− ToT - ToT value of the pixel (raw detector value) 

− FToA - Fast ToA value of the pixel (raw detector value) 

− Overflow - just for internal purpose 
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The ToA and FToA are raw values from the Timepix3 detector. To convert them in nano seconds use this formula: 

 

Example: 

 

Binary File (*.t3r) 

Timepix3 Binary Pixels is similar to t3pa file. Just the numbers are not saved as ASCII, but binary. The file contains 

one pixel after each other. Each pixel in this format: 

 

 

Raw Data File (*.t3p) 

This is a dump of raw communication from the device. The file format is device specific and complex. For more 
information and code please contact daniel.turecek@advacam.com. 

  

mailto:daniel.turecek@advacam.com
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4. Settings of ADVAPIX / MINIPIX TPX3 device 

 

4.1 Setting operation modes 

Mode of operation can be selected via drop-down list in the Detector Settings panel:   

 

ToT & ToA (Pixels)  

Information about the position, the energy and the time of arrival of every detected event is noticed and directly sent to 

PC. The out-put formats are *.t3pa, *.t3p and *.t3r. Data driven based mode is used. 

Mode setting: 

Click on the Pixels measurement type in the drop-down list within the section Measurement. After selecting of 

measurement type check measurement mode that must be set to ToA &ToT  

 

           

 

Only ToT (Pixels) 

Information about the position and the energy of every detected event is noticed and directly sent to PC. The out-put 

formats are *.t3pa, *.t3p and *.t3r. Data driven mode is used. 

Mode setting: 

The setting of this mode is same as the setting for ToT & ToA (Pixels). Select measurement mode to Only ToT instead of 

option ToT & ToA in the drop-down list for Mode measurement is required. 
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Event + iToT (Frame or Integral) 

Frame-based mode measurement. Measurement outputs: one 10-bit image representing the number of events per 

pixel and one 14-bit image representing integral measured energy. Images can be saved as *.pmf files or *.txt files. 

Mode setting: 

Click on the Frame or Integral measurement type in the drop-down list within the section Measurement. After selecting of 

measurement type check measurement mode that must be set to Event + iToT  

          

4.2 Useful tips and how-tos 

PIXET Pro is being developed in Advacam s.r.o. as desktop application for expert users. It implements full control of the 

Timepix- / Medipix-based detectors and it is used within manufacturing processes (testing, calibration, …) as well as 

during the preceding development phase of the devices. Since the application is very powerful, inexperienced user 

could set the device to non-functioning state. Recovery from such case is loading the factory settings shipped with 

the detector. 

Here are several tips for more effective and comfortable use: 

• Composition of panels on the right side of the PIXET Pro window can be configured in Panels in menu bar. 

• Orientation of the image (rotation, mirroring) can be customized in View drop-down list in menu bar 
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• To keep the aspect ratio of the image click on View → Ensure Aspect ratio menu bar. 

• Default colormap is gray. Colormap can be selected via drop-down list under the multicolored icon located in 

main toolbar. 

 

 

• Image Properties Panel allows to adjust brightness and contrast of the displayed images by setting the range 

to be displayed. Auto range options provides automatic adjustment. 

• Advanced Image Properties anel allows to set gamma correction for better visibility of features within 

measured sample. 

• PIXET Pro allows opening and showing previously saved images by drag and drop into image area of the PIXET 

Pro window. When multiple images are drag and dropped, one can browse them using blue arrows in the 

main toolbar. 

 

 

• Images can be zoomed by holding the left mouse button in the frame, dragging the mouse to create a 

selection rectangle and releasing the mouse button. To restore the original frame size, double click on the 

image. 
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• Application output including error messages are shown in Messages panel. 

 

• In case of hardware disconnection, the device can be reconnected by clicking File  Reconnect in menu bar 

without restarting PIXET Pro application. 

4.3 Practical examples of measurements 

Example 1 : Measurement in ToA & ToT 

Setting of operation mode: 

1. Set the device to Pixels operation type as described above 

2. Check the mode in Dettector Settings. Mode ToA & ToT must be set. 
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Controlling the measurement parameters via Measurement panel: 

1. Set the exposure time for measurement in seconds using Time [s] text box. 

 

 

2. Checking the Repeat checkbox and setting the number of repetitions using the text box underneath will 

cause repeating the defined measurement several times. Setting the number of repetitions to zero value 

means “repeat forever”. If the Repeat checkbox is unchecked, the number of repetitions is not in use. Every 

repetition can be saved in several ways. How to save the data into the required file outputs is described 

below. 

Setting the file output  

Click on the More Measurement Settings (red labeled box above) button in the Measurement panel. 

New window will appear. Select the output form in the drop-down list within the Repetition Settings 

→ Output:  

• Suffix to file name (r_index) – every repetition will be save as a separate file 

• Separate directory – every repetition will be saved in to its own directory 

• Same file – all repetitions will be gradually saved into one file 
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3. Check box File output for data saving (if is need) 

Automatic saving of measured data 

Check File output in Measurement panel for automatic saving. Then click on the button with three 

dots. A system dialog window will appear to Select the target destination and filename. Confirm it by 

clicking the Save button. Measured data are saved automatically during the measurement. A warning 

dialog will appear if the file name and destination is used for another measurement. 

Two files are saved by default to each frame: 

1. data file (*.t3pa,*.t3r or *.t3p) 

2. description file (.info) which contains information about the device, used configuration, 

measurement settings, etc. 

4. Press Start measurement 

Starting the measurement 

Start / stop the measurement using Start / Stop button on the Measurement panel. Progress of the 

measurement is shown in the status bar at the bottom of the window. Once the measurement is 

finished, the measured frame is shown in the image preview area of the PIXET Pro window.  
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1If you measure with high intensity flux check the following parameters: 

Check the following setting before you start the measurement. Uncheck the “ProcessData” and 

“DummyAcqNegativePolarity” in the tab Readout in More Detector Setting dialog which is accessible from the main 

PIXET Pro window on the right side under the panel Detector setting. These two parameters influence the 

preprocessing of the data and if enable can slow down the data readout. 

 

Fig. 3. More detector settings main window 

Set value 400 to the field DDBlockSize and value 1000 to the field DDBuffSize. Set Pixels mode in the panel 
Measurement.  The meaning of these parameters is following:  

Block size – the data are readout from the device in blocks (chunks) in order to optimize the data 
throughput. The size of this block is specified by the Block size parameter (in MB). The block 
size cannot be greater than the Buffer size. The data blocks read from the device are filled with 
measured data and dummy bytes in case there is no data coming from the chip. Therefore the 
block size can also influence the speed of the readout. If the block size is big and the radiation 
intensity is very low, it might take several seconds to read the full block. However, for high 
intensity measurements, it is neccessary to setup the block size to higher numbers (e.g. 600 
MB).  

Buffer size - this parameter represents the amount of memory in MB that is reserved for the measured data. 
This buffer is filled with the data blocks and if saving of the data is enabled the data are saved 
to disk and the used memory is released for next measured data block.  If the saving of the 
data is not enabled, only data blocks tha t fits into this memory will be measured. If the buffer 
size is set e.g. to 1000 MB 

The data must be read out to the memory. The data are saved to disk after the measurement and later processed.  

 
1 These parameters are available and enabled only for AdvaPIX TPX3. Mini PIX TPX3 has these parameters partially preselected. 
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Example 2: Measurement in only ToT 

Setting of operation mode: 

1. Set the device to Pixels operation type as described above 

2. Check the mode in Dettector Settings. Mode only ToT must be set. 

 

         

Controlling the measurement parameters via Measurement panel: 

See. Example 1. 

 

Example 3: Measurement in Event Count & Integral ToT  

Setting of operation mode: 

1. Set the device to Frames (a) or Integral (b) operation type: 

2. Check the mode in Dettector Settings. Mode Event + iToT must be set. 
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Controlling the measurement parameters via Measurement panel: 

1. Select type of measurement in Type drop-down list 

a. For single acquisition select Frames and set parameter Count to 1. 

b. Integral - several acquisitions are added to one frame. Number of acquisitions to be added is defined 

by parameter Count. 

2. Set the exposure time of individual frame acquisitions in seconds using Time[s] text box. 

3. Checking the Repeat checkbox and setting the number of repetitions using the text box underneath will 

cause repeating the defined measurement several times. Setting the number of repetitions to zero value 

means “repeat forever”. If the Repeat checkbox is unchecked, the number of repetitions is not in use.  

4. Check box File output for data saving (if is need) 

Automatic saving of measured data 

Check File output in Measurement panel for automatic saving. Then click on the button with three 

dots. A system dialog window will appear to Select the target destination and filename. Confirm it by 

clicking the Save button. Measured data are saved automatically during the measurement. A warning 

dialog will appear if the file name and destination is used for another measurement. 

Two files are saved by default to each frame: 

1. data file (*.txt) that contains two sub-frames: The first one represents number of counts in 

every pixels and the second one frames represent integral measured energy in every pixel 

2. description file (*.dsc) which contains information about the device, used configuration, 

measurement settings, etc. 

Manual saving of measured data 

Click on Save Data option. A pop-up window will appear. Save the data to the required form 

according to forms descriptions. 

5. Press Start measurement 

Starting the measurement 

Start / stop the measurement using Start / Stop button on the Measurement panel. Progress of the 

measurement is shown in the status bar at the bottom of the window. Once the measurement is 

finished, the measured frame is shown in the image preview area of the PIXET Pro window. 
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5. Advanced control using Python Scripting plugin 

Python Scripting plugin allows the user to perform complex measurements controlling the detectors automatically 

via Python commands and scripts. The Python Scripting embeds a full python 2.7 interpreter including the standard 

python libraries. All standard functionality of python is threfore accessible. Please refer to www.python.org or 

www.learnpython.org for more information about Python programming language. 

Click on the icon on the right edge of the main toolbar to start the Python Scripting plugin. Choose Python Scripting 

from the list. A new window with simple editor will open. The bottom part of the plugin window contains a python 

console, where python commands can be run one by one with immediate output. The console also contains the 

output of executed python script. 

 

  

http://www.learnpython.org/
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The PIXET Pro API (Application Programming Interface) is accessible in the scripts via a pixet variable. This variable 

represents the IPixet object that provides all the necessary methods to get information about all connected devices, 

log messages to log file, access the PIXET Pro menu, etc. A list of all available objects, methods and constants of the 

PIXET Pro API can be displayed by clicking Help →Function List... in the main menu of the Python Scripting window. 
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5.1 Practical examples 

Script #1 

Detector settings for acquisition measured in data driven mode ToT & ToA 
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Script #2 

Detector settings for acquisition measured in Event mode (Event & iToT) 
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6. Plugins for proccesing and evaluation of the data 

The PIXET Pro software provides three data processing tools for data generated by TPX3. These tools allow visualizing 

different types of spectra, identifying various types of particles and also displaying and saving images, maps and 

histograms. One of these tools makes it possible to convert the data from complicated coded format to much clearly 

arranged format. The spectral data processing are the following: 

1. Clustering for advanced data processing 

2. Spectral imaging for easy processing of the spectra 

3. TPX3 Data Converter 

How to set and control these tools is explained and described in the text below. 

6.1 Spectral Imaging 

The following text describes the use of spectral imaging with Timepix3 detectors operated in the 

“Pixels” mode. 

Connect the detector, start PIXET Pro Under the "icon is the list of installed plugins. Select the “Spectra imaging 

plugin” 
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Switch the type measurement from Frames to Pixels in the main window of the PIXET Pro. The spectra imaging plugin 

activates automatically the required calibrations. However, it is necessary to make sure that the default energy 

discrimination threshold is entered in the main PIXET Pro window. 

The Timepix3 device measures directly a stream of events which are subsequently added to the spectrum.  Each hit 

or particle track is recognised and all the energy deposited by each particle often into several pixels is summed. The 

result is the total deposited energy in the sensor. This value is then added into the global spectrum as well as to the 

local spectrum of each individual pixel. The total spectrum can be inspected within the plugin window. The slider 

under the spectrum plot allows selecting the image at given energy to be show in the preview on the lefthand side. 

The following images show incorrect and correct settings. 

 

 

 

The plugin window allows selecting the minimum energy in the measured spectrum, number of 

energy bins and the total measurement time. The “zoom” option allows splitting the acquired image into sub-pixels 

(NxN where N is the value 

of the zoom parameter). It is available only for the sum image (the “sum” checkbox selected) 

The measurement is started simply by pressing the start button in the spectra plugin. Checking 

the “Save to file” check box saves data  to Timepix3 required file format. This file can be replayed later on for 

instance to change the spectrum binning settings. A name of file is has to be selected each time the measurement is 

started. 

The processed spectra could be saved after the measurement by clicking “Save as spectrum” 

which saves the results into a text single file. Each line of the file contains spectrum of a single 

pixel. Clicking “Save as frames” allows saving the measured spectrum as a sequence of images where each image 

corresponds to a single energy bin.  
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6.2 Clustering 

The Clustering module preforms on-line or off-line identification of the particle traces in images recorded by PIXET 

Pro, performs their energy calibration, shape analysis and sorting. The module generates various types of results: 

Histograms, images, 2D maps, lists, logs. 

6.2.1 Features of the software 

• Processes images of radiation taken by PIXET Pro software 

• Identifies particle traces in images = Clusters 

• Performs data calibration (for each pixel independently) 

• Calculates measures describing properties of particle traces 

• Applies predefined sorting criteria 

• Saves identified traces to “Cluster log” file 

• Generates histograms, images, maps 

• Supports “Energy mode” (ToT) and “Time mode” (TPX) of Timepix detector 

 

Using Track Processing Tool 

The Clustering tool processes frames provided by preselected device via PIXET Pro software. The parameters of the 

device such as exposure time or triggering are controlled by PIXET Pro. The track processing tool therefore doesn’t 

control the data taking. Whenever PIXET Pro takes the new frame it is automatically send for processing to the 

“Clustering” tool.    

Clusters  

The Timepix3 data files passed to the track processing tool contain traces of ionizing particles. Each particle track is 

identified as continuous area of neighboring pixels in the frame. Such set of pixels is called “Cluster”. The tool 

identifies individual clusters and process them according to preselected criteria. 

Clusters analysis parameters and OK Clusters 

The “Clustering“ tool can evaluate a number of parameters for each identified cluster. User can specify certain 

acceptance criteria for selected parameters. Typically the criteria are given as a range of allowed parameter values. 

Clusters which are positively evaluated are assigned with “OK” flag and they are often referred as “OK clusters” in 

the software. An example of this method is shown in following figure. 
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There are many parameters describing shape of clusters. The analysis would be very slow if all of them would have 

to be evaluated for each cluster. Thus the inactive parameters, which are not needed since no criterion is defined for 

them, are not calculated. All active parameters are calculated in sequence from the most simple to the most 

complicated. Validity of each acceptance criterion is tested immediately when the corresponding parameter is 

determined. If such criterion is negative evaluated then all other (more complicate) parameters and criteria are not 

evaluated. 

Generating of cluster log files 

The identified clusters can be saved to special output files called “cluster logs”. The cluster log is ASCII file containing 

many frames. For each of them there is list of clusters. Each cluster is described by single row where a list of pixels 

belonging to that cluster are listed. Each pixel is described by three numbers “[X,Y,value]” where X,Y are pixel 

coordinates (integer) and value (double) is the pixel value (usually energy or time). The Cluster log file format is very 

simple so that these files are often used as an input for further analysis by other software (Matlab or Python scripts 

…). Saved Cluster log file can be replayed many times later refining sorting criteria.   

  

Cluster touches border 

Small Cluster 
(gamma ray) 

Not round 
Cluster 

(pile-up) 

All Clusters OK Clusters 
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Cluster log file structure. Frames are separated by “Frame” row with frame number, frame time stamp (in seconds) 

and frame exposure time in seconds. Each row following the Frame row contains single cluster which is given as list 

of its pixels [X,Y,value], where “X,Y” are pixel coordinates (integers) and “value” is pixel value (double). 

Main window 

The “Clustering” tool is opened always for one particular imaging device. The device can be either real physical 

detector (e.g. Timepix) connected to the computer or virtual device such as “Dummy device” or “File device”. The 

name of the used device is displayed in caption of “Clustering” window as shown in figure below. 
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The main window of the Clustering plugin can be opened from menu of the PIXET Pro software main window as 

illustrated in the following figure: Select the device which will act as a source of the data in the tab bar, go to “Tools” 

menu and select “Clustering”. 

 

 Part of the PIXET Pro main window with highlighted menu item used for opening of the 
 “Clustering” plugin for selected device. 
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Control panel 

The control panel allows to start/stop processing of the events being collected by the device. Before start it is 

possible to check what log files should be saved during the data processing. 

 

Control: 

Button “Start/stop”:  

When started, then the “Clustering” tool waits for events being measured by device. Each event measured 

by PIXET Pro is directed to this tool and processed according to criteria. 

Button “Clear data” 

All data within the tool are erased. All histograms, spectra, images and statistics are cleared. The button 

doesn’t change the start/stop state. 

Saving: 
Check box “Log all clusters”  

When checked the “file save as window” appears where user has to choose the name and location for the 

log file. All identified clusters will be saved to the log file. This check box has to be selected before starting 

with start button. The check box is cleared automatically when processing is finished pressing “stop” button. 

Check box “Log OK clusters”  

When checked the “file save as window” appears where user has to choose the name and location for the 

log file. Only clusters evaluated as OK will be saved to this log file. This option has to be selected before 

starting with start button. The check box is cleared automatically when processing is finished pressing “stop” 

button. 
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Check box “Log not OK clusters”  

When checked the “file save as window” appears where user has to choose the name and location for the 

log file. Only clusters evaluated as not OK will be saved to this log file. This option has to be selected before 

starting with start button. The check box is cleared automatically when processing is finished pressing “stop” 

button.  

Replaying: 
Button “Replay cluster log” 

When clicked the “file open window” appears where user has to choose the cluster log file. The file will be 

replayed processing all stored data. The execution can be stopped by stop button. The device has to be 

stopped during replaying of the log files. Otherwise the data being measured by PIXET Pro would be 

processed as well. 

 

6.2.2 Image display 

Some processing results are generated in form of images. These images are visualized in image display. The control 

of this display is simple not requiring special description. 
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Image display visualizes images generated automatically during data processing. The generated image to be shown is 

selected in combobox (bottom-left). The image range is controlled automatically by the red button (top-right) if 

“Auto” pushbutton is checked. If auto option is unchecked then pair of edit boxes (top-right) are used for image 

range selection. The selected image can be saved as ASCII matrix pressing “Save selected image” button. 

The current image data can be saved anytime to ASCII matrix pressing one of two buttons below the image: 

Save all – save all “Frame options” 

Save sel – saves selected “Frame option”. If the current image represents one of series of images of the same type 

then the message box is displayed asking whether just displayed complete series should be saved as a 

spectra or images. 
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The selection of the image to be shown is done in the “Image” combo-box. The available items are: 

OK data Frame of OK clusters (bad clusters are removed) 

Bad Data Frame of Bad clusters (not complying the conditions) 

Raw sum Sum of all raw frames 

OK sum Sum of all OK clusters 

Bad sum Sum of all Bad clusters 

Cluster count In this image the pixel corresponding to cluster center is 
incremented by one for each OK cluster. 

Average cluster size Every pixel of this image contains average cluster size 
(number of cluster pixels) for all clusters with center in 
this pixel. 

Average cluster volume Every pixel of this image contains average cluster volume 
(energy) for all clusters with center in this pixel. 

Average cluster height Every pixel of this image contains average cluster height 
(maximal pixel) for all clusters with center in this pixel. 

Const Height cluster count Per pixel cluster height spectrum. For each cluster height 
the image of number of such clusters is generated. The 
height range is defined in parameter group “Generated 
results” item “Generate per pixel spectra” and its sub-
items. The image to be shown is selected by item “Show 
per pixel spectral image”. 

Const volume cluster count Per pixel cluster volume spectrum. For each cluster 
volume the image of number of clusters with equal 
volume is generated. The volume range is defined in 
parameter group “Generated results” item “Generate 
per pixel spectra” and its sub-items. The image to be 
shown is selected by item “Show per pixel spectral 
image”. 

Const volume cluster size sum Auxiliary image for “Const volume avrg cluster size” 

Const volume avrg cluster size Maps average cluster size for clusters of the same 
volume (energy). The volume range is defined in 
parameter group “Generated results” item “Generate 
per pixel spectra” and its sub-items. The image to be 
shown is selected by item “Show per pixel spectral 
image”. 
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6.2.3 Cluster Analysis display 

The multipurpose area in the right part of the main window serves for displaying of various spectra types.  

Spectrum 

In “Spectrum mode” It is possible to select one or several of many different spectra generated. The available options 

are: 

Global clstr size Cluster size spectrum for All clusters and OK clusters (cluster size = 
number of pixels in the cluster) 

Global clstr volume Cluster volume spectrum for All and OK clusters (cluster volume = sum 
of values of all pixels in the cluster = total energy) 

Global clstr height Cluster height spectrum for All and OK clusters (cluster height = 
maximal pixel value in the cluster)  

Per clstr size volume Cluster volume spectra shown independently for several cluster sizes. 
It is shown for All clusters (not for OK only). The number of these 
spectra is set in “Generated results”, item “Number of per clstr size 
spectra”. 

Pixel clstr volume Cluster volume spectrum for single specific pixel (pixel is selected 
clicking to the image display or by coordinates in “Generated results”, 
item “Selected pixel”. 

Cluster count Spectrum of number of clusters in the image. 

 

6.2.4 Statistical panel 

Statistics panel shows current status/progress of data processing and displays statistical data, parameters of device 

and cluster analysis parameters. The fields in the statistical panel are self-explanatory. 
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6.2.5 Cluster analysis parameters 

This is the most important part of the “Clustering” tool. The set of parameters is divided to several parameter 
groups: 

 

• General  

• Calibrations 

• Clusters 

• Spectra  

• Results 
 

 

Each item in the parameter list represents either some processing parameter or discrimination criterion for decision 

on the cluster quality (bad or OK cluster). Whenever the discrimination criterion is defined as a comparison of some 

value with custom threshold level (e.g. Min cluster size = 10) then software uses no sharp inequality for decision - 

greater or equal or smaller or equal 

General 

This parameter group doesn’t need to be changed. 

 
Frame width 

defines width of an active matrix.  

Frame height  

defines height of an active matrix 

Sub Frame Index  

Specifies data measured in frame mode to be processed (if needed) 

 

Calibration 

This is the important part of parameters. All parameters here deal with corrections of the input data. Per pixel 

energy calibration is applied here. 

 
Calibrate  

 If switched on then the data will be calibrated using calibration matrices below.  

Correct Timewalk  

It anabeles the time walk correction. The devices are not standardly calibrated for a Timewalk  correction 
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Use calibration in config   

data will be calibrated using matrices taht are part of the detector configuration. Detector must be connected int 

this case.   

Calibration  File A B C T  

Matrices of calibration coeficients A,B,C,T. The sizes of these matrices have to fit to size of the frames being 

processed. Use browse button to fill these fields.  

 

Clusters  

This parameter group allows to separate clusters according to basic integral cluster measures such as their size 
(number of pixels in the cluster), total energy (volume of the cluster), maximal energy deposited in one pixel (cluster 
height) or maximal distance of the pixels within the cluster (Cluster Length).  

Min cluster height, Max cluster height 

Restriction to the minimal/maximal cluster height: Cluster height is the value of the pixel with biggest signal 
within the cluster. This value corresponds to largest deposited energy in ToT mode or to biggest Time-stamp in 
Time mode.  

Min clstr roudness, Max cluster roudness 

Minimal and maximal cluster roudness. Roudness ranges from zero (not round) to one (perfect circle). Good value 
for recognition of alpha particles is 0.9. 

 
Cluster roudness is expressed as ratio r/rmax. 

 

Min cluster size, Max cluster size 

Minimal/Maximal number of pixels within the cluster. 

  

Size: 14

Bord: 15.66 (14 pixs)

Roud: 0.826

Circ: 0.961

Circle with area equal to  

cluster size, radius r 

Circle 
circumscribing 
radius rmax 

Circle inscribed 

Cluster center 
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Min cluster volume, Max cluster volume 

Minimal/maximal deposited energy calculated as sum of values of all pixels of the cluster.  

Min border pixels, Max border pixels 

Minimal and maximal distance of any border pixel from circle with area equal to cluster size 

Min inner pixels, Max inner pixels 

Number of inner pixels can be restricted. Some clusters are composed only of border pixels (e.g. some electron 
tracks or muon tracks). 

 

Spectra 

Global Cluster size, Clobal Cluster volume, Global Cluster Height, Per Cluster Volume, Cluster Count, Per Pixel 
Spectra 

The limits for value of properties. These limits are used for ranges of spectrum  

 

Results 

Generate Per Pixel Spectra 

For per pixel energy calibration, for XRF imaging or for spectroscopic transmission imaging it is often needed to 
measure/generate the energy spectrum for each pixel. Such processing is enabled here. Number of channels is 
given below. 

Max TOA Diff for new frame 

Is the maximal value  in time betweem clusters to create new frame to cluster log –virtual „frame“. Basically you 
can control grouping of clusters by the time setting 

Timepix3 XRF 

If check the Correction Enabled the inner XRF events generated by the sensor (CdTe) itself will be 
reconstructed.  

Min. And Max Volume set the range of energies for the clusters that correspond with internal XRF of Cd and 
Te.  

ToA difference set the maximum time window in there the coincidences are detected. 

Two clusters are considered to be coincident if their time stamp doesn’t differ more than time window 
width. This number is specified in time periods and depends on the clock frequency. 

Distance is the distance of each coincidence partner from the pivot (the cluster that was detected early ) is 
evaluated and its value is checked with given range. 

Remove (no=reconstruct) enabled a remove of XRF clusters from the original spectrum. 
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Timepix3 Compton 

If check the Correction Enabled the Compton scattering clusters will be removed from the originally 

measured spectrum. The removed clusters are in coincidences and they have energy that corresponds with a 

value that is calculated based on Compton Scattering formula. 

 

ToA difference set the maximum time window in there the coincidences are detected. 
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6.3 Timepix3 data converter 

Data converter is suitable tools for data conversion from a coded data file *.t3r into much clearly arrange format 

*.t3pa. This tool is useful if you want to process the data outside the PIXET Pro in another Software such as Matlab or 

Python. 

The converter is hidden under the bookmark Tools. The pop-up window will appear when you click on Timepix3 
Data in the mentioned bookmark above. 
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Select the file for conversion and find the path where the data will be stored. Press Convert. The processed data you 

find in the terminal folder in the *.t3pa format. How the structure of *.t3pa data format looks like it is described in 

the section TPX3 data formats. 
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7. Release history 

 
Date Changes 

20/04/27 Release 
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8. Copyright 

 

ADVACAM s.r.o. 

U Pergamenky 1145/12 

170 00 Praha 

Czech Republic 

Tel: +420 603 444 112 

Email: info@advacam.com 

www.advacam.com 
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